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Purpose: N4BP3 is a ubiquitination-related gene that plays a pivotal role in neurology and neoplasia. Studies have demonstrated its 
essential function in axonal and dendritic branching, promoting hepatocellular carcinoma and breast cancer. Our previous research 
reveals that N4BP3 enhances inflammatory responses by modulating the NOD2 signaling pathway. It is crucial to investigate 
whether N4BP3 regulates inflammatory bowel disease (IBD) through the TLR4 signaling pathway and to elucidate the underlying 
mechanisms.
Methods: Lipopolysaccharides (LPS) were used to activate the TLR4 pathway in THP-1/Caco-2 cells. THP-1/Caco-2 cells were 
transfected with either N4BP3 overexpression or knockdown plasmids, generating N4BP3-overexpressing or N4BP3-deficient cell 
lines. For in vivo studies, colitis was induced in mice using dextran sodium sulfate (DSS). Additionally, negative control and N4BP3- 
knockdown C57BL/6 mouse models were established via intraperitoneal injection of control or N4BP3-targeting adeno-associated 
virus (AAV).
Results: LPS stimulation significantly upregulated N4BP3 expression in THP-1/Caco-2 cells compared to sterile water treatment (P < 
0.05). In N4BP3-overexpressing cells, LPS induction led to significantly higher expression of TNF-α, IL-1β, IL-6, and IL-8 mRNA, as well 
as phospho-NF-κB p65 protein, compared to wild-type THP-1/Caco-2 cells (P < 0.05). Conversely, these inflammatory markers were 
markedly downregulated in N4BP3-knockdown THP-1 cells following LPS stimulation (P < 0.05). In DSS-induced colitis models, N4BP3- 
knockdown mice showed decreased phospho-NF-κB p65 but increased IκBα protein expression in colonic tissues compared to DSS-treated 
control mice (P < 0.05). Furthermore, we observed interaction between N4BP3 and IκBα, with N4BP3-overexpressing THP-1 cells 
demonstrating significantly elevated K48-linked ubiquitination levels versus controls.
Conclusion: LPS upregulates N4BP3 expression, which subsequently enhances K48-linked ubiquitination of IκBα, leading to NF-κB 
pathway activation, and exacerbating IBD progression. These findings suggest N4BP3 as a potential therapeutic target for developing 
novel IBD treatments.
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Introduction
Inflammatory bowel disease (IBD) is a slow-acting nonspecific intestinal inflammatory disease with a growing 
prevalence.1 Although the pathogenesis of IBD has been extensively studied, uncertainties remain to be clarified. 
Earlier research has shown that IBD is the result of a combination of factors, including susceptibility genes, the immune 
system, and host microorganisms,2–5 with intestinal immune disorders playing an important role.6

Activation of Toll-like receptors (TLRs) has been demonstrated to promote the intestinal immune imbalance and the 
progress of IBD.7 Structurally, TLRs are type I transmembrane glycoproteins characterized by leucine-rich repeat (LRR) 
domains that recognize both microbe-associated molecular patterns (MAMPs) and damage-associated molecular patterns 
(DAMPs).8 In addition, TLRs also contain a structural domain similar to the interleukin I receptor family (TIR), which 
has been recognized to initiate downstream signaling pathways.8 Among various TLR subtypes, TLR1-10 is universally 
expressed in mammals. TLR1, TLR2, TLR4, TLR5, TLR6, and TLR10 are expressed in cell membranes, while TLR3, 
TLR7, TLR8, and TLR9 are expressed in organelle membranes.9 Of particular relevance, TLR4 is predominantly 
expressed on the plasma membrane of monocytes, macrophages, and dendritic cells.10 It recognizes molecular lipopo-
lysaccharides (LPS) from the bacterial cell wall, then initiates MyD88-dependent intracellular signaling,11,12 and further 
activates the signaling molecules IRAK4 and IRAK1, TRAF6, TAK1 and TAB2/3, NEMO, and IKKα/β. Eventually, 
TLR4 can induce IκBα degradation and release NF-κB into the nucleus (ie, the NF-κB pathway) or activate the MAPK 
pathway, which stimulates cytokine release and promotes inflammation.13

The NF-κB signaling pathway is an important cellular signaling pathway that plays a key role in a variety of 
physiological and pathological processes in cells. This pathway consists of two distinct branches: the canonical 
(classical) and non-canonical (alternative) pathways. IκBα is a protein kinase that binds to p50/p65 heterodimers and 
p65 homodimers in the cytoplasm.14 IκBα can be degraded by ubiquitinating enzymes, which can lead to the p65 proteins 
entering into the nucleus, initiating the synthesis of proinflammatory cytokines, and activating the NF-κB signaling 
pathway.15 The activation of NF-κB signaling pathway drives the inflammatory pathologies of IBD.16

The ubiquitination ligase NEDD4 binding protein 3 (N4BP3) has been identified as an important gene affecting 
neural development in earlier studies.17,18 Recently, it has also been associated with multiple tumor diseases, including 
cervical cancer,19 hepatocellular carcinoma,20,21 tongue cancer,22 breast cancer,23 hypoxic diseases,24 and antiviral 
immunity.25 In breast cancer, N4BP3 mediates the ubiquitinated degradation of E-calmodulin,23 and in antiviral 
immunity, it was demonstrated to interact with and promote the ubiquitination of MAVS.25

Ubiquitination is a post-translational modification of proteins.26 This enzymatic process forms a heteropeptide bond between 
the lysine residue of a substrate protein and the carboxyl group of glycine on a ubiquitin protein through a series of processes.27 

Thus, ubiquitination can regulate the degradation, transport, and signaling of substrate proteins.28 Usually, K27-linked ubiqui-
tination is involved in DNA damage responses; K29-linked ubiquitination is an inhibitor of Wnt signaling; K33-linked 
ubiquitination is associated with protein transport; K48-linked ubiquitination and K11-linked ubiquitination promote the 
degradation of proteasomes; K63-linked ubiquitination and M1-linked ubiquitination play an important role in the activation 
of the NF-κB signaling pathway.26 In addition, ubiquitination modifications can modulate TLR4 receptor-mediated signaling.29 

For example, the ubiquitin ligase TRAF6 can lead to polyubiquitination of its own lysine 63 linkage, thereby recruiting TAK and 
TAB proteins.30 Pellino can bind with IRAK1 and cause it to undergo lysine 63-linked polyubiquitination.31

Our previous study revealed that N4BP3 activates the NOD2-MAPK/NF-κB pathway in IBD by promoting poly-
ubiquitination of the lysine 63 linkage of the RIPK2 protein.32 In the study, we tested the expression of N4BP3 in colon 
tissues of IBD patients and control people. The result showed that N4BP3 expression was significantly higher in the 
colon of IBD patients than in controls. We constructed N4BP3-overexpressed THP-1 cells and induced them with 
muramyl dipeptide (MDP). The results showed that MDP-induced TNFα, IL-8 mRNA and phospho (P)-P65, P-ERK, 
P-JNK, and P-P38 proteins were significantly elevated in THP-1 cells after overexpressing N4BP3. We constructed 
N4BP3 knockdown C57BL/6 mice and fed them with dextran sodium sulfate (DSS). The results showed that DSS- 
induced colitis was significantly reduced in mice after knocking down N4BP3. We demonstrated that N4BP3 interacts 
with RIPK2 and promotes its K63-linked ubiquitination with immunoprecipitation experiments.32 In this paper, we aimed 
to further investigate the relationship between N4BP3 and TLR4 in IBD.
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Materials and Methods
Cell Culture
The THP-1 cell line was purchased from Procell Life Science & Technology Co., Ltd. and cultured in the RPMI 1640 
medium containing 10% fetal bovine serum (FBS) and 1% penicillin-streptomycin (P/S). The Caco2 cell line was 
purchased from Suzhou Haixing Biosciences Co., Ltd. and cultured in the DMEM medium containing 10% FBS and 1% 
P/S. All cells were cultured in an incubator at 5% CO2, 95% O2 and 37°C.

Receptor Activator
LPS (TLR4 activator) was purchased from MedChemExpress (MCE) corporation (Shanghai, China). Pam3csk4 (TLR1/2 
activator) was purchased from MedChemExpress (MCE) corporation (Shanghai, China).

Plasmid Transfection
1) Place an appropriate number of cells in 12-well cell culture plates and wait until the cell confluence reaches 70% to be 
used for transfection. 2) Prepare the transfection mixture (per well): add 1.5 μL of Lipo3000 (Thermo Scientific, USA) 
into 25 μL of MEM medium; add 500 ng of DNA plasmid (Public Protein/Plasmid Library, China) and 1 μL of P3000 
(Thermo Scientific, USA) into 25 μL of MEM medium; mix the solutions well and rest for 13 minutes. 3) Add the 
transfection mixture prepared into cell culture plates and perform transfection for 24–72 hours (h).

Both N4BP3 overexpression and knockdown plasmids were purchased from the Public Protein/Plasmid Library. 
N4BP3 knockdown plasmid sequence: sh1: CGCTTTGACAAGTGCCGCATT; sh2: GCAACGGGAAAGGCTTCCTAT; 
sh3: GCCAGAAGACAGCAGAGATTA; NC: GTTCTCCGAACGTGTCACGTT. The efficiency of N4BP3 overexpres-
sion or knockdown in cells was verified by detecting N4BP3 mRNA or protein expression.

Mouse Model
C57BL/6 mice were randomly allocated into four experimental groups: 1) Blank control group: received sterile drinking 
water ad libitum; 2) DSS control group: drank 5% DSS solution for 6 days; 3) N4BP3 knockdown group: injected 
intraperitoneally with N4BP3-targeting adeno-associated virus (AAV-shN4BP3) followed by 5% DSS treatment for 6 
days; 4) Negative control group: injected intraperitoneally with negative control AAV (AAV-scramble) followed by 5% 
DSS treatment for 6 days. All mice were maintained on standard rodent chow throughout the experiment. Three weeks post- 
viral injection, N4BP3 knockdown efficiency was confirmed by immunohistochemical analysis of colonic tissue sections.

Real-Time Fluorescence Quantitative PCR
1) Collect the cells and mix with 1 mL of Trizol thoroughly. 2) Add 200 μL of trichloromethane into the cells and shake 
vigorously, then perform centrifugation. 3) Collect 500 μL of supernatant and mix it with 500 μL of isopropanol gently, 
then perform centrifugation. 3) Discard the supernatant, add 500 μL of anhydrous ethanol, and perform centrifugation. 4) 
Discard the supernatant, add 10–20 μL of sterile and enzyme-free water. 5) Reversely transcribe the RNA to cDNA using 
the RevertAid First Strand cDNA Synthesis Kit (Thermo Scientific, K1622, USA). 6) Add 5 μL of cDNA, 10 μL of 
qMIX (Roche, 06924204001, USA), 2 μL of primer, and 3 μL of ultrapure water to eight consecutive tubes, mix well, 
and place the tubes in a fluorescence quantitative PCR instrument for detection. 7) Analyze the data for Cq values.

Primer sequences (5′→3′): GAPDH Forward primer: AATCCCATCACCATCTTCCA; GAPDH Reverse primer: 
CCTGCTTCACCACCTTCTTG. N4BP3 Forward primer: AACGAGCCTGCCGACTATG; N4BP3 Reverse primer: 
ACTTTGCATGGATAGGAAGCC. TNFα Forward primer: AAGCCTGTAGCCCATGTTGT; TNFα Reverse primer: 
AGTCGGTCACCCTTCTCCA. IL-1β Forward primer: GACGGACCCCAAAAGATGAA; IL-1β Reverse primer: 
CAGCCACGAGGCTTTTTGTT. IL-8 Forward primer: TTGGCAGCCTTCCTGATTT; IL-8 Reverse primer: 
TCAAAAACTTCTCCACAACCC.
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Immunoprecipitation and Immunoblotting
Immunoprecipitation: 1) Collect cells, add lysate and cocktail to enable full lysis, and perform centrifugation. 2) Take 500 μL 
of supernatant and mix thoroughly with antibody, then suspend at 4°C for 4–6 h. 3) Add 500 μL of suspension into magnetic 
beads and suspend for another 4–6 h to obtain the antigen-antibody-magnetic bead mixture. 4) Add an appropriate amount of 
loading buffer and heat in a thermostat at 100 °C for 5 min. 5) After cooling, collect the loading buffer for immunoblotting.

Immunoblotting/Western blot: 1) Assemble the electrophoresis apparatus properly, connect the power supply after sample 
loading, and set the program as 160mv, 45 minutes. 2) Place the gel and PVDF membrane after electrophoresis in the transfer 
apparatus, connect the power supply, and set the program as 200mA, 58 minutes. 3) Wash the PVDF membrane with PBST for 
10 minutes and then immerse the PVDF membrane in the protein-free rapid closure solution for 15 min on a shaker. 4) Wash the 
PVDF membrane with PBST for another 10 minutes and then immerse the PVDF membrane in the primary antibody at 4 °C for 
10 h. 5) Wash the PVDF membrane with PBST three times for 10 minutes each, and then immerse the PVDF membrane in the 
secondary antibody for 50 minutes on a shaker. 6) Wash the PVDF membrane with PBST three times for 10 minutes each. 7) Add 
an appropriate amount of developing solution dropwise to the PVDF membrane, and develop and fix with a chemiluminescence 
instrument. 8) Continue with detection of other antibodies after the antibody has been eluted with the antibody stripping solution.

Antibodies and dilutions: GAPDH (Abcam, ab9484, 1:5000), N4BP3 (Proteintech, 16733-1-AP, 1:600), IκBα (Abways, 
CY5026, 1:1000), P-P65 (CST, 3033, 1:1000), p-P38 (CST, 4511, 1:1000), P-ERK (CST, 4370, 1:2000), P-JNK (CST, 
4668, 1:1000), TLR4 (Bioswamp, PAB47910, 1:600), MyD88 (Abways, CY5681, 1:1500), TRAF6 (Bioswamp, 
RMAB50064, 1:600), IRAK1 (Abways, CY6917, 1:600), IRAK4 (Abways, CY6916, 1:600), TAK1 (Abways, CY7057, 
1:1000), NEMO (Abways, CY6843, 1:1000), TNFα (Abcam, ab307164, 1:1000), IL-1β (Abcam, ab283818, 1:1000).

Quantitative analysis of Western blot bands using ImageJ. 1) Launch ImageJ and open the target image file. 2) Convert 
image to 8-bit format (Image → Type → 8-bit). 3) Perform background subtraction: navigate to “Process” → “subtract 
background”, select “Light background” option. 4) Configure measurement parameters: Select “Analyze” → Set 
“Measurements”, Check: “Area, Mean gray value, Integrated density”. 5) Set scale unit to pixels (Analyze → Set Scale 
→ Unit: pixels). 6) Invert image (Edit → Invert). 7) Band quantification: use the rectangular box selection tool to select each 
band of the immunoblot; Click “Analyze” → “Measure”, then integrated density (IntDen) values can be obtained. Protein 
expression data were normalized by dividing the target protein’s IntDen value by that of the loading control.

Immunohistochemical Staining
1) Fix the paraffin sections of embedded colon on slides and heat in a 55 °C oven for 30 minutes. 2) Immerse the sections in 
xylene for 10 minutes, and then sequentially in anhydrous ethanol, 95% ethanol, 85% ethanol, and distilled water for 5 minutes 
each. 3) Further immerse the sections in 3% H2O2 for 10 minutes. 4) Immerse the sections in the antigen repair solution and 
heat in a microwave oven. 5) After drying, draw a circle around the outer edge of the tissue, add a drop of sealing solution, and 
rest for 30 minutes. 6) Discard the sealing solution, add a drop of anti-IκBα (Abways, CY5026, 1:3200) or P-P65 (Epizyme, 
R013789, 1:3200), and rest at 4°C overnight. 7) Immerse the sections in PBST for 5 minutes, then add the secondary antibody 
dropwise, and rest at 37 °C for 30 minutes. 8) Immerse the sections in PBST for 5 minutes, and after air-drying, add the DAB 
color development solution dropwise for 5–15 seconds, followed by double-distilled water. 9) Rinse the sections with water, 
add a few drops of hematoxylin, rest for 1 minute, and then rinse with water. 10) Immerse the sections sequentially in 85% 
ethanol, 95% ethanol, and anhydrous ethanol for 4 minutes each and in xylene for 2 minutes. 11) Add a few drops of neutral 
gum, cover the coverslips, and air-dry the sections for subsequent observation and analysis.

Data Analysis
All experiments in this paper were repeated at least three times. The statistical differences between each two groups were 
compared using a t-test, while the statistical differences between more than two groups were compared using one-way 
ANOVA. P < 0.05 indicated statistical significance. The results were plotted using GraphPad Prism 8.0.1.
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Results
N4BP3 Expression Is Upregulated After Activation of TLR4 by LPS
To investigate LPS-induced N4BP3 expression, THP-1 cells were treated with 1 μg/mL LPS for different times (0, 1, 3, 6, 
12, and 24 h). Quantitative real-time PCR (qPCR) analysis revealed significant upregulation of N4BP3 mRNA levels at 1, 3, 
and 6 h post-induction compared to untreated controls (0 h) (P < 0.05), with peak expression observed at 3 h (Figure 1A). 

Figure 1 Continued.
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Western blot analysis demonstrated a similar temporal pattern for N4BP3 protein expression, showing significant increases 
at all time points (1–24 h) (P < 0.05), with maximal protein levels achieved at 6 h (Figure 1B).

For dose-response experiments, THP-1 cells were exposed to increasing LPS concentrations (0, 0.1, 0.5, 1, 5, and 
10 μg/mL) for 3 h. qPCR analysis indicated dose-dependent N4BP3 mRNA induction, with significant upregulation 
observed at all tested concentrations (0.1–10 μg/mL) compared to untreated controls (P < 0.05). The maximal transcrip-
tional response occurred at 1 μg/mL LPS (Figure 1C). Correspondingly, Western blot analysis revealed parallel dose- 
dependent increases in N4BP3 protein levels, with peak expression similarly observed at 1 μg/mL LPS (Figure 1D).

Subsequently, Caco-2 cells were treated with 5 μg/mL LPS for different times (0, 1, 3, 12, 24, 48, and 72 h). qPCR 
analysis revealed significant upregulation of N4BP3 mRNA levels at 24 and 48 h post-induction compared to untreated 
controls (P < 0.05), with peak expression observed at 24 h (Figure 1E). Consistent with transcriptional changes, Western 
blot analysis demonstrated significant increases in N4BP3 protein levels at 3, 24, and 48 h (P < 0.05), with maximal 
protein accumulation also occurring at 24 h (Figure 1F).

For dose-response assessment, Caco-2 cells were exposed to graded LPS concentrations (0, 0.1, 1, 5, 10, and 20 μg/ 
mL) for 24 h. qPCR results showed dose-dependent N4BP3 mRNA induction, with significant upregulation at 0.1–10 μg/ 
mL LPS (P < 0.05) and maximal response at 5 μg/mL (Figure 1G). Protein analysis confirmed this pattern, showing 
significant N4BP3 elevation across all tested concentrations (0.1–20 μg/mL) (P < 0.05), with peak expression again 
observed at 5 μg/mL LPS (Figure 1H).

THP-1 cells were pretreated with specific kinase inhibitors targeting ERK1/2 (U0126, 10 μM), JNK (SP600125, 
20 μM), p38 (SB203580, 10 μM), or NF-κB (BAY11-7082, 5 μM) for 1 h prior to LPS stimulation (1 μg/mL, 1 h). qPCR 
and Western blot analyses revealed that BAY11-7082 pretreatment significantly attenuated LPS-induced N4BP3 expres-
sion at both mRNA (Figure 1I) and protein levels (Figure 1J) (P < 0.05). In contrast, inhibition of ERK1/2, JNK, or p38 
signaling pathways showed no significant effect on LPS-mediated N4BP3 upregulation (P > 0.05).

In our previous experiments, we collected colon tissues from Crohn’s disease (CD) patients and normal colon tissues 
(colon tissues from colon cancer patients that were 15 cm from the tumor margins), then detected the expression of 

Figure 1 Changes in N4BP3 expression after inducing THP-1/Caco2 cells with LPS. (A and B) Changes in the expression of N4BP3 mRNA (A) and protein (B) after 
inducing THP-1 cells with LPS (1 μg/mL) for different times. (C and D) Changes in the expression of N4BP3 mRNA (C) and protein (D) after inducing THP-1 cells with 
different concentrations of LPS for 3 h. (E and F) Changes in the expression of N4BP3 mRNA (E) and protein (F) after inducing Caco2 cells with LPS (10 μg/mL) for 
different times. (G and H) Changes in the expression of N4BP3 mRNA (G) and protein (H) after inducing Caco2 cells with different concentrations of LPS for 
24 h. Statistical analysis using paired t-test. *P < 0.05 represents a significant difference between the group below the asterisk (*) indicator and the control group (the 
first group). Indicator “ns” representing no significant difference between the group below the indicator “ns” and the control group (the first group). The error bar 
represents the mean ± SD. (I and J) Changes in the expression of N4BP3 mRNA (I) and protein (J) after inducing THP-1 cells with U0126 (ERK1/2 inhibitor), SP600125 (JNK 
inhibitor), SB203580 (P38 inhibitor), and BAY11-7082 (NF-κB inhibitor), respectively. Statistical analysis using One-way ANOVA. * P < 0.05, representing a significant 
difference between the groups at either end of the horizontal line. Indicator “ns” representing no significant difference between the groups at either end of the horizontal 
line. The error bar represents the mean ± SD.
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N4BP3 protein with immunohistochemical staining. The results showed that the expression of N4BP3 in the colonic 
tissues of the CD patients was significantly higher than that of controls.32

Overexpression of N4BP3 Promotes the Release of LPS-Induced Cytokines
To investigate the role of N4BP3 in TLR4 pathway activation, we established N4BP3-overexpressing cell lines by 
transfecting THP-1 and Caco-2 cells with N4BP3 expression plasmids. Following LPS stimulation (1 μg/mL, 4 h), qPCR 
analysis revealed significantly elevated expression of proinflammatory cytokines in N4BP3-overexpressing cells com-
pared to vector controls (P < 0.05).

In THP-1 cells, N4BP3 overexpression markedly enhanced LPS-induced mRNA expression of TNF-α, IL-6, and IL-8 
(Figure 2A–D). Similarly, in Caco-2 cells, N4BP3 overexpression significantly potentiated LPS-mediated upregulation of 
IL-1β, IL-6, and IL-8 mRNA levels (Figure 2E–H). These findings demonstrate that N4BP3 amplifies TLR4-dependent 
inflammatory responses in both THP-1 and Caco-2 cell lines by promoting cytokine production.

Knockdown of N4BP3 Inhibits the Release of LPS-Induced Cytokines
To further clarify whether and how N4BP3 mediates the pro-inflammatory effects in the TLR4 pathway, we constructed 
N4BP3-knockdown THP-1 cells by transfecting the cells with knockdown plasmids. Then, quantitative PCR and Western 
blot were performed to detect the changes in the expression of cytokine mRNAs and proteins after LPS induction. The 
results showed that among the three types of plasmids investigated, knocking down plasmid 1 (sh1) exhibited the best 
knockdown efficiency of N4BP3 in THP-1 cells (Figure 3A). Compared to untreated THP-1 cells, the expression of LPS- 
induced cytokines TNFα, IL-6, and IL-8 mRNAs was significantly downregulated (P < 0.05) in N4BP3-knockdown 
THP-1 cells (Figure 3B–E). In consistency, the expression of TNFα and IL-1β proteins was also significantly down-
regulated (P < 0.05) (Figure 3F). The results further indicate that N4BP3 can mediate the TLR4 pathway to promote 
inflammation.

Figure 2 Changes in LPS-induced mRNA expression of cytokines after overexpressing N4BP3 in THP-1/Caco2 cells. (A–D) Changes in LPS-induced mRNA expression of 
TNFα (B), IL-6 (C), and IL-8 (D) after overexpressing N4BP3 (A) in THP-1 cells. (E–H) Changes in LPS-induced mRNA expression of IL-1β (F), IL-6 (G), and IL-8 (H) after 
overexpressing N4BP3 (E) in Caco2 cells. Statistical analysis using One-way ANOVA. * P < 0.05, representing a significant difference between the data. The error bar 
represents the mean ± SD.
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Overexpression of N4BP3 Promotes LPS-Induced Activation of the NF-κB Pathway
While activation of TLR4 was revealed to ultimately promote the production and release of cytokines via the MAPK- 
ERK/JNK/P38 pathways or the NF-κB pathway, we aimed to further investigate the more specific TLR4-related 
pathways in which N4BP3 plays a pro-inflammatory role. For this purpose, we constructed N4BP3-overexpressed 
THP-1 cells and induced the cells with LPS. Then, Western blot was performed to detect the protein expression of 
signaling molecules in the TLR4 pathway. The results showed that the expression of LPS-induced P-NF-κB p65 protein 
was significantly upregulated in N4BP3-overexpressed THP-1 cells compared to untreated THP-1 cells (P < 0.05) 
(Figure 4), but there were no significant changes in the expression of p-ERK1/2, p-JNK, and p-P38 (P > 0.05) (Figure 4). 
This suggests that N4BP3 can promote cytokine release via TLR4/NF-κB signaling.

Consistent with previous reports, administration of 3–5% DSS in drinking water induced colitis in C57BL/6 mice.33 

Building on our prior findings that N4BP3 knockdown attenuates DSS-induced colitis,32 we further investigated this 
effect through a controlled experimental design. Mice were divided into four groups: (1) blank control group (normal 
drinking water), (2) DSS group (5% DSS solution), (3) negative control group (AAV-control + 5% DSS), and (4) N4BP3 
knockdown group (AAV-shN4BP3 + 5% DSS).

Comparative analysis revealed no significant differences between the DSS group and negative control group in terms 
of colonic N4BP3 expression levels, disease activity index (DAI), histopathological scores, or proinflammatory cytokine 
(TNF-α and IL-1β) levels (P > 0.05). In contrast, mice with N4BP3 knockdown exhibited significantly reduced N4BP3 
expression, attenuated disease severity, improved histopathological scores, and decreased TNF-α and IL-1β levels 
compared to negative controls (P < 0.05). These results confirm that N4BP3 knockdown specifically mitigates DSS- 
induced colitis progression.

Figure 3 Changes in LPS-induced expression of cytokines after knocking down N4BP3 in THP-1 cells. (A) Changes in N4BP3 protein expression after transfection of 
plasmids containing different knockdown N4BP3 sequences into THP-1 cells. (B–E) Changes in LPS-induced mRNA expression of TNFα (C), IL-6 (D), and IL-8 (E) after 
knocking down N4BP3 (B) in THP-1 cells. (F) Changes in LPS-induced protein expression of TNFα and IL-1β after knocking down N4BP3 in THP-1 cells. Statistical analysis 
using One-way ANOVA. * P < 0.05, representing a significant difference between the groups at either end of the horizontal line. Indicator “ns” representing no significant 
difference between the groups at either end of the horizontal line. The error bar represents the mean ± SD.
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Figure 4 Changes in LPS-induced protein expression of signaling molecules after overexpressing N4BP3 in THP-1 cells. Changes in LPS-induced protein expression of TLR4, 
MyD88, IRAK1, IRAK4, TRAF6, p-TAK1, NEMO, IκBα, p-P65, p-ERK, p-JNK, and p-P38 after overexpressing N4BP3 in THP-1 cells. Statistical analysis using One-way 
ANOVA. *P < 0.05, representing a significant difference between the groups at either end of the horizontal line. Indicator “ns” representing no significant difference between 
the groups at either end of the horizontal line. The error bar represents the mean ± SD.
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The colon tissues of N4BP3 knockdown group mice and negative control group mice were embedded in paraffin. We 
detected the expression of p-P65 protein and IκBα protein with immunohistochemical staining. The results showed that 
the expression of IκBα protein was significantly upregulated (P < 0.05) (Figure 5A–C) while the expression of p-P65 
protein was significantly downregulated (P < 0.05) (Figure 5D–F) in the colonic tissues of N4BP3 knockdown mice 
compared to the negative control group. This suggests that N4BP3 can activate NF-κB signaling in IBD.

Figure 5 Expression of IκBα protein and p-P65 protein in colonic tissues of mice. (A) Expression of IκBα protein in colon tissues of negative control mice. (B) Expression of IκBα 
protein in colon tissues of N4BP3 knockdown mice. (C) Relative expression of IκBα protein in colon tissues of negative control mice and N4BP3 knockdown mice. (D) Expression 
of p-P65 protein in colon tissues of negative control mice. (E) Expression of p-P65 protein in colon tissues of N4BP3 knockdown mice. (F) Relative expression of p-P65 protein in 
colon tissues of negative control mice and N4BP3 knockdown mice. Statistical analysis using paired t-test. *P < 0.05, representing a significant difference between the data. The error 
bar represents the mean ± SD.
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N4BP3 Interacts with IκBα and Promotes Its Ubiquitination
To explore the specific pathways by which N4BP3 promotes inflammation, we examined the expression of key signaling 
molecules in the TLR4 pathway. After overexpressing N4BP3 in THP-1 cells, it was found that both the expression of 
LPS-induced p-P65 and its upstream IκBα protein were significantly upregulated (P < 0.05) (Figure 4), whereas all other 
upstream molecules were not significantly affected (P > 0.05) (Figure 4). Therefore, we hypothesized that N4BP3 can 
interact with IκBα.

Further, we constructed N4BP3-overexpressed THP-1 cells and induced the cells with LPS. The proteins were then 
extracted and added with the IgG antibody, N4BP3 antibody, and IκBα antibody, respectively, for immunoprecipitation 
and immunoblotting in order to detect the protein expression of N4BP3 antibody, and NEDD4. The results showed that 
the IκBα protein could be pulled down after immunoprecipitation of the N4BP3 antibody compared to precipitation of 
the IgG antibody (Figure 6A), while the N4BP3 protein could be pulled down after immunoprecipitation of the IκBα 
antibody (Figure 6B). This indicated that there are interactions between N4BP3 and IκBα.

Subsequently, we induced both untreated THP-1 cells and N4BP3-overexpressed THP-1 cells with LPS. Then, the 
proteins were extracted and immunoprecipitated with the IκBα antibody, and immunoblotting was performed to detect 
the expression of ubiquitin-K48, N4BP3, and IκBα. The results showed that the K48 ubiquitination level of IκBα was 
significantly upregulated in LPS-induced THP-1 cells overexpressing N4BP3 compared to untreated THP-1 cells 
(Figure 6C), suggesting that N4BP3 can promote the K48-linked ubiquitination of IκBα.

Discussion
Our previous study has revealed that LPS-induced NF-κB signaling was significantly upregulated after overexpressing 
N4BP3, which is believed to be associated with RIPK2 activation. In this paper, we induced THP-1 cells with LPS and 
immunoprecipitated the N4BP3 antibody. The result confirmed that N4BP3 could indeed interact with RIPK2. Besides, it 
was also found that the N4BP3 expression was significantly upregulated after TLR4 activation. Both N4BP3- 
overexpressed THP-1 cells and Caco2 cells could significantly upregulate LPS-induced cytokines, suggesting that 
N4BP3 is able to promote LPS-induced inflammatory responses. However, the upregulated fold of IL-1β, IL-6, and 
IL-8 in Caco2 cells was not as much as in THP-1 cells, which may be due to the lower expression of the TLR4 receptor 
in Caco2 cells. Further, we detected the expression of key signaling molecules in the TLR4 signaling pathway by 
Western blot in LPS-induced THP-1 cells overexpressing N4BP3, and the results demonstrated that N4BP3 enhanced the 
NF-κB pathway but had no significant effect on the MAPK pathway. Moreover, after inducing N4BP3-overexpressed 
THP-1 cells with LPS, only the expression of IκBα was significantly altered among the upstream signaling molecules.

Figure 6 Target protein and ubiquitination modification assays for N4BP3 interactions. (A and B) Expression of different proteins detected by immunoblotting after 
immunoprecipitating LPS-induced THP-1 cells overexpressing N4BP3 with the N4BP3 antibody (A) and the IκBα antibody (B). (C) Expression of different proteins detected 
by immunoblotting after immunoprecipitating LPS-induced control THP-1 cells and THP-1 cells overexpressing N4BP3 with the IκBα antibody.
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Upon activation of the TLR4 pathway, IκBα is phosphorylated on Ser32 or Ser36, and then undergoes Lys48-linked 
ubiquitination of Lys21 or Lys22; this process will release NF-κB into the nucleus to stimulate cytokine synthesis and 
release.34,35 The Siah E3 ubiquitin protein ligase 1 (SIAH1) has been shown to promote the ubiquitination of IκBα, 
activate NF-κB signaling, and promote cardiomyocyte pyroptosis, therefore exacerbating the progression of inflamma-
tory cardiomyopathy.36 The ubiquitinating enzyme β-TrCP can bind to IκBα and promote its ubiquitinated 
degradation,37,38 while another ubiquitinating enzyme, NEDD4L, can induce the ubiquitination of IκBα in an IKK- 
2-dependent manner, which promotes NF-κB signaling and exacerbates diabetic retinopathy.39 In addition, the binding of 
the deubiquitinating enzyme USP14 to IκBα was reported to reduce the K48 ubiquitination of IκBα and inhibit TNFα- 
induced cell death in the head and neck squamous cell carcinoma (HNSCC).40 The deubiquitinating enzyme USP39 can 
reduce K48-linked ubiquitination of IκBα and inhibit inflammatory responses.41 In line with the existing studies, our 

Figure 7 Schematic diagram of the mechanism by which N4BP3 activates TLR4-NF-κB signaling. In inflammatory bowel disease, the activation of TLR4 in macrophages 
promotes the expression of N4BP3 via the NF-κB pathway. N4BP3 can further promote the ubiquitination of IκBα K48 linkages, facilitate the entry of NF-κB into the 
nucleus, and promote the production and release of cytokine. This figure was created with BioGDP.com.
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results indicate that N4BP3 can bind to IκBα and promote K48-linked ubiquitination of IκBα, thereby facilitating NF-κB 
signaling and exacerbating LPS-induced inflammatory responses and DSS-induced colitis.

Interestingly, we found that N4BP3 also promotes the NF-κB signaling pathway and promotes pro-inflammatory 
cytokine release through other TLRs. We transfected THP-1 cells with the N4BP3 overexpression plasmid and induced 
TLR1/2 receptors with Pam3csk4. The results showed that THP-1 cells overexpressing N4BP3 significantly up-regulated 
Pam3csk4-induced TNFα, IL-8 mRNA, and P-P65 protein expression (P < 0.05) (Supplementary Figure 1).

Hexu Han et al found that N4BP3 increased transducer and activator of transcription 3 (STAT3) and the activity of the 
STAT3 signaling pathway by interacting with lysine acetyltransferase 2B (KAT2B) and regulating the distribution of 
acetyl histone H3 (Lys27) (H3K27ac) in its promoter region, which promotes microvascular proliferation and accelerates 
malignant progression of tumors in hepatocellular carcinoma.21 A genetic predisposition to overactivation of STAT3 in 
monocytes and epithelial compartments compromises innate defenses, allowing low-level bacterial infections to fester 
and eventually cause disease, which includes IBD.42 This suggests that n4bp3 may promote IBD by mediating STAT3 or 
other signaling pathways. The NF-κB signaling pathway also plays an important role in diseases such as tumors, which 
suggests that N4BP3 may regulate tumors such as HCC through the NF-κB signaling pathway.

Common biomarkers of IBD include C-reactive protein, erythrocyte sedimentation rate, leucine-rich α2 glycoprotein, 
fecal calprotectin, the fecal immunochemical test and antineutrophil cytoplasmic antibodies, anti-Saccharomyces cere-
visiae antibodies. These biomarkers play an important role in diagnosing IBD and predicting treatment outcomes.43 

Detecting the expression of N4BP3 in the blood from IBD patients and normal populations, analyzing the correlation 
between the expression of N4BP3 in the blood and IBD, which may provide a new method for the diagnosis of IBD.

Traditional treatments for IBD include aminosalicylates, corticosteroids, immunosuppressants, and cyclosporine.44 

Despite improvements, it still fails to cure many IBD patients. While targeted therapies offer more possibilities for the 
treatment of patients with IBD. Currently, targeted therapies are used on a mass of IBD patients, which include anti- 
tumor necrosis factor antibodies, anti-IL-12 and anti-IL-23 antibodies, anti-α4β7 integrin antibodies, and sphingosine- 
1-phosphate receptor agonists.45 Anti-N4BP3 antibodies may provide a new targeted therapy, and we expect that an 
inhibitor of N4BP3 can be developed in the near future, as it currently does not exist.

Conclusion
In conclusion, our study revealed an important role of the ubiquitination-associated protein N4BP3 in IBD through 
cellular and mouse experiments. Mechanistically, N4BP3 promotes both the NOD2-MAPK/NF-κB signaling pathway 
through ubiquitination of RIPK2 and the TLR4-NF-κB signaling pathway through ubiquitination of IκBα, which promote 
the release of pro-inflammatory cytokines and inflammation of the colon (Figure 7). Our findings are expected to enrich 
the current pathogenic network of IBD, provide future research direction-developing N4BP3 inhibitors and a new 
therapeutic implication-targeting N4BP3 in IBD.
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